
 

 

I.  ANALÝZA PROTEOMU 
 
A) DVOUROZMĚRNÁ ELEKTROFORÉZA 
 
RNDr. Hana Konečná, Danuše Fridrichová 
 

Dvourozměrná elektroforéza je kombinací dvou elektromigračních metod, které slouží k separaci 
jednotlivých proteinů z komplexní směsi. 
Prvním rozměrem je izoelektrická fokusace, tj. separace proteinů podle jejich izoelektrických bodů 
(pI) v imobilizovaném gradientu pH vytvořeném v polyakrylamidovém gelu (IPG stripu) v prostředí 
ionizovaných látek. K rozdělení proteinů dochází po vložení stripu do elektrického pole. 

Druhý rozměr tvoří denaturační polyakrylamidový gel s obsahem dodecylsulfátu sodného, ve kterém 
dochází k rozdělení předem separovaných proteinů podle relativní molekulové hmotnosti (MW). 

Po provedení dvourozměrné elektroforézy jsou proteiny visualizovány přímo v gelu barvením 
Coomassie Brilliant Blue, stříbrem, fluorescenčně, popř. autoradiograficky.  
Vybraný protein se manuálně vyřízne z gelu, enzymaticky naštěpí na peptidy, které jsou dále 
analyzovány hmotností spektrometrií. K příslušnému MS-spektru je identifikace proteinu dohledána 
z databáze srovnáním s peptidovými spektry známých proteinů. 
 
Praktická část:  
 
Vzorky se připraví acetonovou extrakcí z listů Arabidopsis thaliana buď wild type Columbia 
nebo amp 1 – mutantní linie nadprodukující rostlinné hormony cytokininy. 
1. Extrakce proteinů z listů: 

 listy se rozdrtí v třecí misce v tekutém dusíku 
 přidá se roztok aceton/TCA (kyselina trichloroctová) – vysrážení proteinu 
 centrifugace, pelet se promyje roztokem acetonu (s obsahem EDTA a inhibitorů proteáz) 
 centrifugace, vysušení peletu (tj. proteinový prášek) 

 
2. Solubilizace proteinů: 

 rozpuštění proteinů - 1h třepat při 37 °C v solubilizačním pufru 
 centrifugace, filtrace, stanovení koncentrace proteinu metodou kompatibilní s redukčními 

látkami a detergenty obsaženými v solubilizačním pufru (kit RC/DC, BioRad). 
 
3. Rehydratace IPG stripu se vzorkem 

 Proužky se dodávají v dehydratovaném stavu opatřené ochrannou fólií. Všeobecně lze 
k nanesení proteinového vzorku použít dva postupy přípravy: 
1) rehydratace bez vzorku – po odstranění fólie se proužek nechá rehydratovat  rehydratačním 
pufrem  9-16 hodin, vzorek se nanese před samotnou fokusací. 
2) rehydratace se vzorkem – po odstranění fólie se proužek nechá rehydratovat v 

roztoku rehydratačního pufru obsahujícím vzorek. Tímto způsobem lze dosáhnout 
nanesení velkého množství proteinu (až 1 mg) bez rizika vysrážení. 
2.1) rehydratace se vzorkem pasivní – bez působení elektrického proudu 
2.2) rehydratace se vzorkem aktivní – 50 V, 20°C, 10 –12 hodin 

 V našem případě použijeme postup pasivní rehydratace se vzorkem. Do drážky rehydratační 
vaničky naneseme 50 g vzorku ředěného rehydratačním pufrem. Z IPG stripu opatrně 
sloupneme ochrannou fólii a položíme jej GELEM DOLŮ do drážky se vzorkem (případné 
bubliny je třeba odstranit!). Zalijeme 2 ml minerálního oleje. Rehydratace proužku bude 
probíhat asi 6 hodin (obvykle však používáme rehydrataci přes noc). 

S proužky manipulujeme výhradně pinzetou a v rukavicích !!!  
 



 

 

 
4. Izoelektrická fokusace (1. rozměr) 

 Fokusační podmínky závisí na složení vzorku, jeho komplexitě, na délce stripu a na pH 
rozmezí IPG proužku. Následující podmínky proto berte pouze jako doporučené. 
Na elektrody fokusační vaničky opatrně pinzetou položíme čtverečky speciálního papíru a 
navlhčíme je 8 l deionizované vody. Z rehydratační vaničky vyjmeme proužek a necháme 
odkapat olej. Proužek položíme do fokusační vaničky gelem dolů. Jemně jej přitlačíme na 
elektrody. Zalijeme 2 ml minerálního oleje. Po vložení všech proužků uzavřeme vaničku 
víkem – pozor na orientaci! – a vložíme ji do přístroje. 

 
Podmínky fokusace (pro strip délky 7 cm): 

1. krok: odstranění nadbytečných solí 
 startovní napětí: 150 V 

 čas: 30 min 
2. krok: zvyšování napětí  

 startovní napětí: 150 V 
 konečné napětí: 1500 V 

 čas: 3 h 
3. krok: zvyšování napětí  

 startovní napětí: 1500 V 
 konečné napětí:  2500 V 

čas: 1 h 
4. krok: zvyšování napětí  

 startovní napětí: 2500 V 
 konečné napětí:  3500 V 

celkový počet volthodin: 12000 Vh  
4. krok: závěrečný udržovací  krok 

 napětí: 500 V 
 čas: 24 hodin            

Po ukončení fokusace proužky vyjmeme z drážky, necháme okapat olej a buď strip hned 
použijeme na separaci v druhém rozměru nebo zamrazíme na   –20 °C v hermeticky uzavřené 
nádobce.  

 
5.  SDS-PAGE (2. rozměr) 
 

 Ekvilibrace proužků: Před provedením SDS-PAGE je nezbytné ekvilibrovat proužky v pufru 
obsahujícím dodecylsulfát sodný (SDS). Proužky po rozmražení umístíme do rehydratační 
vaničky obsahující 2.5 ml ekvilibračního roztoku 1 (obsahuje DTT) a 10 minut jemně 
promícháváme na třepačce. Po deseti minutách přemístíme proužek do 2.5 ml ekvilibračního 
roztoku 2 (obsahuje jodoacetamid) a opět mírně promícháváme na třepačce. Jodoacetamid je 
fotocitlivý, ekvilibrační roztok 2 proto chráníme před světlem  alobalem. 

 Po ekvilibraci  přeneseme IPG proužek na polyakrylamidový gel druhé dimenze a zalijeme 0.8 
% agarosou v elektroforetickém pufru s obsahem 0,003% bromfenolové modři. Necháme 
proběhnout standardní SDS-PAGE, gely obarvíme Coomassie Brilliant Blue nebo - pro 
dosažení vyšší citlivosti - stříbrem.  

 

Roztoky pro 2D elektroforézu: 
Solubilizační pufr (totožný s rehydratačním pufrem) 
7M urea,  2M thiourea,  2% CHAPS, 60 mM DTT, 0.8% ampholyte, 0.003% BPB 
 
Ekvilibrační roztoky 
1. 6 M močovina, 0,375 M Tris/Cl, pH 8,8, 2% SDS, 20% glycerol, 2% (w/v) DTT  
2. 6 M močovina, 0,375 M Tris/Cl, pH 8,8, 2% SDS, 20% glycerol, 2,5% (w/v) jodoacetamid 
 



 

 

Agarosa na zalití IPG stripu 
0.8 % agarosa v PAGE elektroforetickém pufru 
 
Elektroforetický pufr  
0,025 M Tris, 0,192 M glycin, 0,1 % SDS 
 
Koncentrace celkového akrylamidu v gelu pro druhý rozměr 2-D elektroforézy: 
Druhý rozměr 2-D elektroforézy provádíme v 12%T gelu: 
 
Barvení gelů Coomassie modří (Coomassie Brilliant Blue R250) 
Barvení Coomassie modří patří mezi nespecifické metody vizualizace proteinů. Při obvyklém způsobu 
barvení Coomassie dochází zároveň k fixaci proteinu do gelu, a to působením 40% methanolu 
v prostředí 10% kyseliny octové. Barvení trvá přibližně 2 – 8 hodin, v závislosti na množství proteinu 
naneseného na gelu, na tloušťce gelu a na koncentraci Coomassie.   
 Po skončení SDS-PAGE označit orientaci gelu odkrojením jednoho z rožků a opatrně přenést gel 

do 0,1% Coomassie R 250. Ponechat  třepat na třepačce přes noc. 
 Následující den vyměnit Coomassie za odbarvovací roztok č. 1. Ponechat na kývačce 30 minut. 
 Vyměnit odbarvovací roztok 1 za odbarvovací roztok 2. Ponechat na kývačce do odbarvení; 

odbarvovací roztok 2 je nutné několikrát vyměnit. V tomto roztoku je gel možné v chladu uchovat 
i několik týdnů. 

 Uchovávání gelů: 
- vysušení mezi celofány 

 - vysušení na papíře pod celofánem 
- naskenování a uchování v elektronické podobě (pokud se gel uchovává pro  

              pozdější analýzu, uchovávat ve formátu tiff, nekomprimovaném) 
 

Roztoky: 
Barvicí roztok Coomassie  
0,1% Coomassie Brilliant Blue R 250 
10% kyselina octová 
40% methanol 

 
Odbarvovací roztok 1 
7% kyselina octová 
40% methanol 

 
Odbarvovací roztok 2 
10% kyselina octová 
5% metanol 
 

Barvení CB je možno též provést komerčně dostupným kitem.  
 
Barvení gelů stříbrem 

Barvení stříbrem je další metodou nespecifické vizualizace proteinů. Principem je vazba 
stříbrných iontů na –SH a –COOH skupiny aminokyselin. Schopnost vázat na sebe stříbrné ionty 
je tedy u každého proteinu jiná v závislosti na jeho aminokyselinovém složení. 

Po proběhnutí elektroforézy v polyakrylamidovém gelu se proteiny v gelu zafixují zředěnou 
kyselinou octovou nebo trichloroctovou. Poté jsou vystaveny působení dusičnanu stříbrného. Při 
vyvíjení v roztoku uhličitanu sodného s formaldehydem dojde k redukci stříbrných iontů na 
stříbro, což se projeví zčernáním míst na gelu, kde je stříbro v proteinech navázáno. 

Stupeň intenzity obarvení lze ovlivnit dobou, po kterou jsou stříbrné ionty vystaveny působení 
vyvíjecího činidla. Redukční reakce se zastaví přidáním kyseliny octové. 



 

 

Pro snížení pozadí a zlepšení kvality detekce je vhodné gel odbarvit Farmerovým odbarvovačem a 
celou proceduru barvení (bez fixace) provést ještě jednou. Stříbro, navázané na proteinech, se totiž 
Farmerovým činidlem nevymyje tak snadno, jako stříbro nespecificky navázané jako „pozadí“. 

 
Veškeré nádobí, použité pro barvení, je nutno pečlivě umýt 1) saponátem, 2) ethanolem, 3) 
destilovanou vodou. Pro přípravu veškerých vodných  roztoků použít pouze destilovanou 
deionizovanou vodu.  

 Po skončení SDS-PAGE proteiny v gelu zafixovat - opatrně přenést gel do 20% trichloroctové 
kyseliny (TCA) a ponechat 20 minut třepat na kývačce. 

 TCA recyklovat, gel promýt 4x 5 minut vodou. 
 Přidat 0,1%  roztok dusičnanu stříbrného. Zakrytou misku ponechat 30 minut třepat na kývačce. 
 Gel propláchnout vodou 10 vteřin a přidat vyvíjecí činidlo. 10 minut vyvíjet v zakryté misce, 

netřepat. 
 Zastavení vyvíjení 1% kyselinou octovou, 10 minut třepat. 
 Promytí gelu vodou, 3x5 minut. Přidat Farmerův odbarvovač, 5 minut třepat. 
 Po odstranění Farmerova odbarvovače promývat gel vodou až do úplného odbarvení. 
 Opět přidat 0,1% roztok dusičnanu stříbrného. Zakrytou misku ponechat 30 minut třepat na 

kývačce. 
 Gel propláchnout vodou, 10 vteřin a přidat vyvíjecí činidlo. Vyvíjet v zakryté misce do objevení 

proužků/skvrn. 
 Zastavení vyvíjení 1% kyselinou octovou, 10 minut třepat. 
 Gel promýt vodou – 15 minut. Uchovávat v chladu ve vodě s 2% (w/v) glycerolem. 
 

Roztoky: 
0,1% AgNO3 
0,1 g AgNO3/100 g roztoku.  
Připravit těsně před použitím (nepřipravovat do zásoby). Uchovávat v temnu. 

 
Vyvíjecí činidlo 
3% uhličitan sodný + formaldehyd 
3 g Na2CO3/100 g roztoku + 50 l 37% formaldehydu 

 
Farmerův odbarvovač 
2% K3Fe(CN)6, 3,2% Na2S2O3x5H2O 
2 g K3Fe(CN)6/100 g roztoku 
3,2 g Na2S2O3x5H2O/100 g roztoku 
Smíchat těsně před použitím 

 
Barvení stříbrem je možno též provést komerčně dostupným kitem.  
 
Gely uchováváme zatavené ve fólii nebo vysušené. 
 
Sušení gelů mezi celofány 
• Odbarvovací roztok 2 vyměníme za 2% glycerol a gel v roztoku ponecháme aspoň 15  
   minut. 
• Ustřihneme celofán (Biometra, BioRad), namočíme a ponecháme ve vodě 10 minut. 
• Poskládáme sendvič a ten vložíme do sušárny gelů. 
• Sušíme 4 hodiny. 
 
2% (w/v) glycerol 
2g glycerolu doplnit na objem 100 ml destilovanou vodou 
 
 



 

 

B)    HMOTNOSTNÍ SPEKTROMETRIE PROTEINŮ  
 

doc. RNDr. Zbyněk Zdráhal, Dr.  
 

Hmotnostní spektrometrie bude použita pro identifikaci vybraných proteinů po jejich 
separaci 2-D elektroforézou (MALDI-TOF MS), resp. po on-line separaci kapalinovou 
chromatografií (ESI-IT MS). Studenti se seznámí s metodou analýzy proteinů pomocí 
hmotnostní spektrometrie včetně proteolytického štěpení a budou samostatně identifikovat 
vybrané proteiny na základě srovnání získaných dat s proteinovými databázemi.  

 
 
Teoretický úvod 
 
MALDI-TOF MS 
 Hmotnostní spektrometrie s ionizací za přítomnosti matrice a detekcí iontů v průletovém 
analyzátoru (Matrix-assisted Laser Desorption/Ionization – Time-of-flight Mass Spectrometry, 
MALDI-TOF MS) je v současné době jedna z nejrozšířenějších  metod identifikace proteinů 
resp. určení jejich primární struktury. V našem případě bude použita metoda založená na 
srovnání hmotností peptidů vzniklých proteolýzou analyzovaného proteinu s proteinovými 
databázemi (peptide mapping, peptide mass fingerprinting).    

Obarvené skvrny vybraných proteinů jsou nejprve vyříznuty z gelů připravených 2-D 
elektroforézou. Vyříznuté kousky gelu s proteiny jsou odbarveny střídavým promýváním v 
acetonitrilu a roztoku hydrouhličitanu amonného. Po odbarvení jsou dithiothreitolem 
redukovány disulfidické můstky mezi cysteiny a následně jsou -SH skupiny alkylovány 
jodacetamidem s cílem zabránit opětovnému vytvoření těchto můstků. Po alkylaci je ke 
vzorkům přidána proteáza (obvykle trypsin) a jsou inkubovány přes noc. Působením proteázy 
jsou proteiny specificky štěpeny na sadu peptidů. Již zmíněný trypsin štěpí protein za lysinem 
nebo argininem směrem k C-konci peptidu. Soubor takto vzniklých peptidů je specifický pro 
daný protein (tzv. peptidová mapa). Po ukončení inkubace jsou peptidy extrahovány kyselým 
vodným roztokem acetonitrilu. 
Extrakt peptidů je pak smíchán s matricí, nanesen na terčík a po krystalizaci je analyzován 
pomocí MALDI-TOF MS. Pro analýzu bude použit přístroj REFLEX IV (Bruker, Brémy, 
Německo). Výsledkem hmotnostně spektrometrické analýzy jsou přesné hmotnosti peptidů. 
Soubor naměřených hmotností peptidů je pak srovnáván pomocí prohledávacích programů 
(např. Mascot, MS Fit) s proteinovými databázemi, resp. s peptidovými mapami vytvořenými in 
silico počítačovým programem pro jednotlivé proteiny uložené ve zvolené databázi. Na základě 
tohoto srovnání lze protein identifikovat s velkou pravděpodobností, případně určit jeho 
homology.  
 
 
LC- MSMS 
 Hmotnostní spektrometrie s ionizací elektrosprejem a iontovou pastí jako hmotnostním 
analyzátorem iontů je další velmi rozšířenou metodou identifikace. Výhodou je možnost on-
line spojení tohoto typu hmotnostního spektrometru s vhodnou separační technikou (HPLC, 
CE). V tomto případě bude identifikace proteinů založená na srovnání hmotností fragmentů 
jednotlivých peptidů vzniklých proteolýzou proteinů v analyzované směsi s proteinovými 
databázemi.    

Směs proteinů je podrobena proteolytické digesci (postup je popsán v předchozím odstavci). 
Směs vzniklých peptidů je pak separována na kapilární koloně kapalinového chromatografu 
(Ultimate, LC Packings). K dávkování vzorků bude použit autosampler (Famos, LC Packings). 
MS/MS analýza separovaných peptidů bude provedena na přístroji Esquire 2000 (Bruker, 
Brémy, Německo). Pro identifikaci jsou pak srovnávány soubory naměřených hmotností 



 

 

fragmentů jednotlivých peptidů pomocí prohledávacích programů (např. Mascot, Protein 
Prospector) s proteinovými databázemi.  
 
 
Proteolytické štěpení 
 

1. Vyříznutí proteinových skvrn z gelu 

 deionizovaná voda 
 skalpel 
 mikrozkumavky (0,5 ml) 

Gel opláchneme vodou a pak skalpelem vyřežeme vybrané skvrny gelu. Vyříznutý gel s 
daným proteinem pak rozkrájíme na kostičky o straně asi 1 mm a vložíme do 
mikrozkumavek. 
 

2. Odbarvení gelu 

 deionizovaná voda 
 50 mM NH4HCO3/acetonitril (1:1, v/v) 
 acetonitril 
 50 mM NH4HCO3 

 
Gel proplachujeme uvedenými roztoky, promytí roztokem pufru a acetonitrilu 
opakujeme 2x, po promytí acetonitrilem nakonec gel usušíme ve vakuové centrifuze. 
 

3. Redukce a alkylace 

 10 mM dithiothreitol/25 mM NH4HCO3 – redukční činidlo 
 55 mM jodacetamid/25 mM NH4HCO3 – alkylační činidlo 
 50 mM NH4HCO3/acetonitril (1:1, v/v) 
 acetonitril 

 
K částicím gelu přidáme redukční činidlo a inkubujeme 1 hodinu při 56 °C, pak roztok 
odstraníme a přidáme na 30 minut alkylační činidlo (lab. teplota, temno). Odstraníme 
roztok alkylačního činidla a propláchneme roztokem pufru v acetonitrilu a pak 
samotným acetonitrilem, opět roztok odpaříme. 
 

4. Proteolytické štěpení 

 trypsin (5 ng/μl) v 25 mM NH4HCO3 
 

Přidáme roztok enzymu, tak aby zakrýval kousky gelu, a inkubujeme při 37°C přes noc. 
 

5. Extrakce peptidů 

 50 % acetonitril/1% trifluoroctová kyselina 
 

Po 10 minutách v ultrazvukové lázni odpipetujeme původní inkubační roztok, pak 
přidáme roztok acetonitrilu a opět dáme na deset minut do ultrazvukové lázně a 
odpipetujeme supernatant (tento krok opakujeme). Jednotlivé supernatanty spojíme. 
 
  

MALDI-TOF MS analýza 
 

1. Příprava peptidového extraktu k analýze 

 matrice - nasycený roztok kyseliny hydroxy �-kyano skořicové  
v 50 % acetonitrilu s 0,1 % trifluoroctovou kyselinou 

 



 

 

Peptidový extrakt smícháme 1:1 s matricí a výsledný roztok (0,5 �l) naneseme na 
terčík. Po vykrystalizování je vzorek připraven k analýze. 

 
2. Vlastní analýza 

Peptidy měříme v reflektronovém modu a za použití externí kalibrace na směs 
standardních peptidů. 

 
 
LC-MSMS analýza 

 

1. LC analýza 

- kapilární kolona s reversní fází C18 
- mobilní fáze acetonitril/voda s přídavkem kyseliny mravenčí (0,1%),  

   gradientová eluce 
2. Vlastní analýza 

Iontová past pracuje v MSMS modu.  
 
 
Identifikace proteinů 
 
Základy práce s databázemi 
 
Seznámíme se s nejdůležitějšími zdroji dat a nástroji pro studium proteinů přístupných na Internetu. 
Použití si vyzkoušíme na několika praktických příkladech v počítačové učebně a studenti vypracují 
několik praktických úkolu. 
 
Typy zdrojů informací a nástrojů 
 
Doc. Dr. Zbynek Zdrahal (zdrahal@sci.muni.cz) 
http://www.sci.muni.cz/LMFR/Proteomika.html 
 
1. Základní data 
– sekvence 
 NCBI (http://www.ncbi.nlm.nih.gov/) 
 Entrez (http://www.ncbi.nlm.nih.gov/Entrez/) 

Expasy (http://www.expasy.ch/) 
SwissProt (http://www.expasy.ch/sprot/) 

 
– struktura 
 PDB (http://www.rcsb.org/pdb/) 
 
2. Nástroje 
– analýza sekvence, srovnávání více sekvencí  

odkaz na Biology Workbench (http://workbench.sdsc.edu/) 
CLUSTAL 
BLAST 
PHYLIP 

– zobrazení struktury 
PDB Java Viewer 
Cn3D (http://www.ncbi.nlm.nih.gov/Structure/CN3D/cn3d.shtml) 
Swiss Pdb Viewer (http://www.expasy.ch/spdbv/mainpage.htm) 
Chime (http://www.mdli.com/support/chime) 

– předpovídání struktury 
Swiss Model (http://www.expasy.ch/swissmod/SWISS-MODEL.html) 



 

 

I-TASSER (http://zhanglab.ccmb.med.umich.edu/I-TASSER/) 
– komplexní 

Biology WorkBench (http://workbench.sdsc.edu/) 
SwissProt Tools (http://www.expasy.ch/tools/) 

 
3. Odvozená a speciální data 
– podobnosti mezi druhy 

COG (http://www.ncbi.nlm.nih.gov/COG/) 
– domény 

PROSITE (http://www.expasy.ch/prosite/) 
– typy skládání 

SCOP (http://scop.mrc-lmb.cam.ac.uk/scop/) 
– fosforylační místa 

PhosphoBase (http://www.cbs.dtu.dk/databases/PhosphoBase/) 
– hmotnostní spektra pro MALDI-TOF, 2-D gely, identifikace z gelu 
 SwissProt 2-D PAGE (http://www.expasy.ch/ch2d/) 
 PeptideSearch (http://www.mann.embl-heidelberg.de/GroupPages/PageLink/peptidesearchpage.html) 
 ProteinProspector (http://prospector.ucsf.edu/) 
– nomenklatura enzymů 

SwissProt ENYZME (http://www.expasy.ch/enzyme/) 
- pohyby proteinů 

MolMovDB (http://bioinfo.mbb.yale.edu/MolMovDB/) 
  
 

 
Vyhodnocení MS dat (samostatná práce) 
 
 Po seznámení se s nejdůležitějšími zdroji dat a nástroji pro studium proteinů přístupných na 
Internetu data získaná MALDI-TOF analýzou (hmoty peptidů) zadáme do prohledávacího programu 
Mascot (Matrix Science) s příslušnými parametry a identifikujeme proteiny z jednotlivých skvrn.   
  
 
Poznámka: 

Proteolytické štěpení a MALDI-TOF analýza bude provedena z části demonstrační formou z časových 
a kapacitních důvodů. Studenti obdrží seznam hmot peptidů pro každý analyzovaný vzorek a  vlastní 
identifikaci proteinů si každý student provede sám. 
 
 

Hledání v databázi proteinů.  
Dr. Phil Jackson 
 
www.expasy.ch 
 
The ExPASy (Expert Protein Analysis System) proteomics server of the Swiss Institute of 
Bioinformatics (SIB)je vytvořen pro analýzu proteinové sekvence a struktury stejně tak jako 
pro 2-D elektroforézu. 
 
Tento server používám k práci s proteiny. 
 

 Databases 
 Tools and software packages 

 
Jak najít námi hledaný protein v databázi.? 



 

 

 European Bioinformatics Institute 
 Swiss Institute of Bioinformatics 
 Georgetown University 

 
1. Bud známe prvotní přístupové číslo: UniProtKB/Swiss-Prot entry P49235 

Potom jdeme přímo do databáze http://www.expasy.ch/expasy_ref.html a zadáme tam číslo. 
2. Nebo známe název enzymu – to bývá nejčastější a potom musíme najít číslo proteinu: 

rostlinná beta-glukosidáza z kukuřice, glycosyl hydrolyse family1, EC 3.2.1.21, 
P49235, BGLC_MAIZE.  

Potom doporučuji jít na webové stránky Prosit - http://www.expasy.ch/tools/scanprosite/ 
 
    * β-glucosidases (EC 3.2.1.21) from various bacteria such as Agrobacterium strain ATCC 
21400, Bacillus polymyxa, and Caldocellum saccharolyticum. 
    * Two plants (clover) β-glucosidases (EC 3.2.1.21). 
    * Two different β-galactosidases (EC 3.2.1.23) from the archaebacteria Sulfolobus 
solfataricus (genes bgaS and lacS). 
    * 6-phospho-β-galactosidases (EC 3.2.1.85) from various bacteria such as Lactobacillus 
casei, Lactococcus lactis, and Staphylococcus aureus. 
    * 6-phospho-β-glucosidases (EC 3.2.1.86) from Escherichia coli (genes bglB and ascB) and 
from Erwinia chrysanthemi (gene arbB). 
    * Plants myrosinases (EC 3.2.1.147) (sinigrinase) (thioglucosidase). 
    * Mammalian lactase-phlorizin hydrolase (LPH) (EC 3.2.1.108 / EC 3.2.1.62). LPH, an 
integral membrane glycoprotein, is the enzyme that splits lactose in the small intestine. LPH 
is a large protein of about 1900 residues which contains four tandem repeats of a domain of 
about 450 residues which is evolutionary related to the above glycosyl hydrolases. 
 

3. Můžeme znát však pouze jen DNA sekvenci – potom doporučuji převést sekvenci do 
proteinové sekvence pomocí Translace a pak použít sekvenci bez stop kodonů. Tato 
sekvence se pak zadá do BLASTu hledání podobných sekvencí a to s velkou 
pravděpodobností Vám ukáže hned první odkaz, který by měl být Váš protein. 

 
Co vše můžeme zjistit z databází. Dalo by se říct, že vše. 
Hmotnost proteinu, isoelektrický bod, zda je monomer nebo vícemer, synonyma proteinu, 
genový název, odkazy na literaturu, funkci, katalytickou aktivitu, jak je protein regulován, 
biofyzikální vlastnosti, lokalizaci, tkáňovou specifiku, podobnost s jinými proteiny, 3D 
strukturu. 
4. Struktura proteinu, pokud byl protein krystalizován a nebo byla zjištěna sekvence 

pomocí NMR, tak lze nalézt na webových stránkách: 
http://www.pdb.org/pdb/explore.do 
Potom musíte znát pdb (protein databank) označení a pakliže ho neznáte, musíte ho znovu 
najít. Označení pdb můžete najít ze základní stránky prositu a nebo si můžete zadat do site 
search (beta-glucosidase maize) a zobrazí se vám seznam beta-glukosidáz z kukuřice 
spolu s mutanty. 
Strukturu můžeme bud stáhnout a prohlížet v staženém prohlížeči jako je RASMOL, nebo 
PYMOL a nebo PDBviewer. 
 
Proteiny můžeme také podrobit doménové analýze SMART http://smart.embl-
heidelberg.de/ nebo PFAM http://www.sanger.ac.uk/Software/Pfam/ 
 
CATH Protein Structure Classification 



 

 

CATH je strukturovaná klasifikace proteinových domén na čtyřech úrovních Class(C)-
třída, Architecture(A)-architektura, Topology(T)-umístění and Homologous superfamily 
(H)-stejná rodina  
 

SCOP: Structural Classification of Proteins. 
 



 

 

 C) URČENÍ KONFORMACE 3-D PODOBNÝCH PROTEINŮ 
 
Mgr. Tomáš Klumpler, Ph.D. 
 
 
Úkol: s pomocí databáze makromolekulárních struktur určete terciární strukturu(y) 
proteinu(ů) podobnou(é) proteinu se zadanou sekvenci aminokyselin, vytvořte obrázek 
molekulární struktury a stručně popište výsledek 
 
Nástroje:  
1) databáze proteinových struktur PDB, http://www.rcsb.org/pdb/home/home.do 
2) hledání struktur proteinů s podobnou 3D strukturou, např. nástroj PDBeFold                     
http://www.ebi.ac.uk/msd-srv/ssm/ 
3) Vizualizace výsledků, vytvoření ilustrativního obrázku, pomocí např. UCSFR Chimera 
(https://www.cgl.ucsf.edu/chimera/)  
 
Příklad:  hledání struktur podobných k haloalkan dehalogenáze LinB ze Sphingomonas paucimobilis 
UT26. 
 
sekvence (ve formátu FASTA)  
 
>1D07:A|PDBID|CHAIN|SEQUENCE 
MSLGAKPFGEKKFIEIKGRRMAYIDEGTGDPILFQHGNPTSSYLWRNIMPHCAGLGRLIACDLIGMGDSDKLDPSGPERY 
AYAEHRDYLDALWEALDLGDRVVLVVHDWGSALGFDWARRHRERVQGIAYMEAIAMPIEWADFPEQDRDLFQAFRSQAGE 
ELVLQDNVFVEQVLPGLILRPLSEAEMAAYREPFLAAGEARRPTLSWPRQIPIAGTPADVVAIARDYAGWLSESPIPKLF 
INAEPGALTTGRMRDFCRTWPNQTEITVAGAHFIQEDSPDEIGAAIAAFVRRLRPA 
 
Postup: 
1) vyhledání struktur s danou primární sekvencí v databázi PDB: 

 
 



 

 

 
 
2) hledání strukturně podobných proteinů, pomocí např. PDBeFold 

 



 

 

3) vizualizace a strukturní srovnaní, např. pomocí UCSF Chimera 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

II. TECHNOLOGIE REKOMBINANTNÍCH 
PROTEINŮ 

 
 

Nedostupnost dostatečných množství homogenních preparátů biologicky významných eukaryontních 
proteinů byla jedním ze základních omezení jejich studia. Tento limitující faktor byl odstraněn 
rozvojem molekulárně biologických technik, umožňujících produkci studovaných eukaryontních 
proteinů v dostatečném množství. Důležitým předpokladem bylo vypracování technik jejich produkce 
v heterologních, převážně bakteriálních expresních systémech. Protože prokaryontní transkripční 
aparát nedokáže odstranit nekódující oblasti eukaryontních genů, je nezbytné získat nejprve DNA 
komplementární k mRNA genu pro daný protein (cDNA) metodami založenými na reverzní 
transkripci mRNA. Pro účely nadprodukce rekombinantních proteinů lze využít řadu expresních 
plazmidů se silnými promotory pro kmeny Escherichia coli. Inzerce cDNA do vektoru je usnadněna 
přítomností mnohočetného klonovacího místa za promotorem, který má být použit k řízení exprese 
cDNA.  
    
 

 A) Příprava bakteriální kultury pro izolaci plazmidové DNA 
 
Do bakteriální zkumavky obsahující 5 ml sterilního LB media s ampicilinem (100 mg/l) inokulujte 
pomocí bakteriální kličky expresní kulturu (kmen BL21 (DE3) pLys  nesoucí expresní konstrukt 
pRSETA::Zm-p60.r) a nechte inkubovat přes noc při 37°C za stálého třepání. 
 
 

Izolace plazmidové DNA z obou bakteriálních kultur pomocí ZR 
Plasmid Miniprep kitu 
 
 Bc. Martina Válková 
 
1. centrifugujeme 3 ml (2x 1,5 ml) narostlé bakteriální kultury 1 min při 14000 rpm; po každém 
 stočení supernatant slijeme do odpadní kádinky 
2. pelet resuspendujeme ve 200 l činidla P1 (červené) 
3. přidáme 200 l činidla P2 (zelené) a jemným překlápěním (2- 4x) zamícháme (při kompletní  lyzi 
buněk by měl roztok být čirý, fialový, vazký)  
4. ihned přidáme 400 l činidla P3 (žluté) a opět jemným překlápěním zamícháme (roztok 
 zežloutne) 
5. inkubujeme 1 - 2 min při RT, potom centrifugujeme 2 min při 14000 rpm. 
6. supernatant přeneseme opatrně do kolonky a centrifugujeme 30 s při 14000 rpm 
7. kolonku po odstranění roztoku promyjeme 200 l činidla Endo-Wash Buffer a opět 
 centrifugujeme 30 s při 14000 rpm 
8. kolonku promyjeme 400 l činidla Plasmid Wash Buffer a centrifugujeme 1 min při  14000 rpm 
9. přidáme 30l deionizované sterilní vody a eluci plazmidové DNA provedeme centrifugací 1 min 

při 14000 rpm    
10. změříme absorbanci vyizolované DNA spektrofotometricky při λ = 260nm a  vypočítáme její kon-

centraci 
        
 
 
 



 

 

Sekvenační  analýza  DNA 
 

Bc. Martina Válková 
 
 Cílem práce je ověřit čtecí rámec klonovaného genu Zm-p60.1 v expresním vektoru pRSET A. 
Informace o používaném plazmidu pRSET A jsou dostupné na stránkách www.invitrogen.com. Pro 
sekvenování se použije univerzální sekvenační primer T7.  

 
Teoretický úvod 

 
 Sekvenační analýza bude provedena metodou značených terminátorů za použití 
Genetického analyzátoru ABI PRISM 3130, který pracuje na bázi kapilární elektroforézy. 
V praxi to znamená, že se nejprve s daným plazmidem, neznačeným primerem a sekvenačním 
kitem provede sekvenační reakce (cycle sequencing). Používaný kit (ABI PRISM BigDye 
Terminator Cycle Sequencing Ready  Reaction Kit) obsahuje enzym AmpliTaq polymerázu 
FS, směs nukleotidtrifosfátů a fluorescenčně značených terminátorů. Každý ze čtyř 
terminátorů (ddNTPs-dideoxynukleotidtrifosfátů) přítomných v reakci nese jinou 
fluorescenční značku. Při sekvenační reakci jsou tyto terminátory do rostoucích řetězců 
průběžně inkorporovány, řetězec je ukončen a zároveň označen značkou příslušnou k dané 
bázi. 

 Vzniklé fragmenty jsou rozděleny kapilární elektroforézou. CCD kamera analyzátoru pak 
snímá fluorescenci excitovanou laserovým paprskem ze všech čtyř použitých značek současně 
(protože emisní maxima jsou při rozdílných vlnových délkách, je možné analyzovat všechny 
fragmenty současně). 

 
Příprava sekvenační reakce 

 
Na sekvenační reakci napipetujeme  pro každý zkoumaný plazmid do PCR zkumavky: 
 

plazmidová DNA (do reakce celkem 400ng )                 2,0  l*
deio voda                                                                            3,5  l* 
primer  (konc. 10 pmol/l)                                                  0,5 l 
BD kit                                                                                     2 l 
5X BD sekvenační pufr                                                          2 l 
 

* údaj je orientační, závisí na koncentraci plazmidové DNA (uvedené hodnoty jsou pro koncentraci 
200 ng/l). Pokud je koncentrace nižší než 100 ng/l, je potřeba vzorek zahustit, při koncentraci nad 
400 ng/l je naopak potřeba vzorek naředit. 

 
Obsah zvortexujeme, zcentrifugujeme a vložíme do PCR cykleru. 
 
Sekvenační reakce 

 
Na PCR cykleru nastavíme následující program: 
 

Teplotní rampa na 96°C 
Cyklus 35x:    96°C  10s 
                       50°C   5s 
                       60°C   4 min 
Teplotní rampa na 4°C, výdrž  

 
Celková doba reakce je asi 3 hodiny. 
 
 



 

 

Přečištění produktů sekvenační reakce 
 

Do eppendorfky 1,5 ml  napipetujeme: 
125 mM EDTA                                       2,5 l 
95% ethanol (ledový -20ºC)                    25 l 
celý obsah PCR zkumavky 
 

Zvortexujeme a necháme DNA 10 min vysrážet ve tmě. 
Centrifugujeme 20 min při 14000 rpm. 
Opatrně pipetou odsajeme ethanolovou vrstvu, aniž bychom poškodili pelet (pozor, pelet není 
vidět!!). 
Pelet opláchneme 30 l 70% ethanolu. 
Krátce (2 min) centrifugujeme při 14000 rpm. 
Opět opatrně odsajeme ethanol. 
Sraženinu krátce dosušíme v termobloku na 95oC.  

 
Příprava vzorku pro automatický sekvenátor 
 
Vzorek pro sekvenátor připravíme následovně: 

 Pelet v eppendorfce rozpustíme v 15 l Hi - Di formamidu. 
 Důkladně protřepeme na Vortexu a krátce zcentrifugujeme. 
 Celý obsah opatrně přeneseme do destičky určené pro automatický dávkovač 

sekvenátoru. 
  

 
 

Vyhodnocení sekvencí v programu Work Bench 
 
 Bc. Martina Válková 

 
Proč vlastně sekvenovat? 
 
Při práci s rekombinantními proteiny je naprosto nezbytné mít klon, který je zcela bez chyby – tedy 
konkrétněji – bez mutací a ve správném čtecím rámci. Názornou ukázku, co může způsobit záměna 
JEDNÉ aminokyseliny, uvidíte sami v praktiku. 
Proto je nutné každý klon, se kterým pracujete, ověřit – tj. osekvenovat a sekvence zkontrolovat. 
Obvzláště pak v případech, kdy provádíte PCR (chyba polymerasy) nebo vzorek od někoho dostanete. 
Praktická rada: nevěřte nikomu! 
K ověření lze využít programy volně dostupné na internetu, jako je např. program Workbench 
(http://workbench.sdsc.edu/). V praktiku si ukážeme, jak sekvence pomocí tohoto programu 
kontrolovat.  Sekvence lze sice kontrolovat i manuálně, ale tento způsob rozhodně nelze doporučit: 
nemůžete vyloučit chybu a je to pracné a zdlouhavé. 
 
Obecný postup při ověřování správnosti vzorku: 
 
vzorek →  izolace DNA  →  sekvenace  →  sekvence  → Workbench: srovnání se známou, 
BEZCHYBNOU sekvencí  →  vyhodnocení. 
 
 
 
 
Výstup z programu Workbech může vypadat například takto: 
(při srovnání se vzorovou sekvencí zcela jasně vidíte, zda je sekvence ověřovaného vzorku v pořádku) 



 

 

 
 
 
 
CKI_jap9wtT7      --------------------------------------
GAGATATACCATGGGCAGCAGC 
CKI1_dna          
CAAAGGGAATCATTGCTGAGACATTCTTTTGTTGCAGAGAGATCACCAAAACATAAAGTC 
                                                        *****   * *     *    
* 
 
CKI_jap9wtT7      CATCATCATCATC--ATCACAGCAGC-
GGCCTGGTGCCGCGCGGCAGCCATATGGCTAGC 
CKI1_dna          
CAAGAAGAGGGGCCAAGCTCAATGTTTAACAAAAAATTAGGTAAGAGGATAATGGCATCA 
                  **  *  *    *  * * **        *          *    **    *****   
 
CKI_jap9wtT7      
ACAGATTCAGAGAGTGAGACTAGGGTCAAGTCAGTGCGTACCGGTCGAAAGCCTATTGGG 
CKI1_dna          
ACAGATTCAGAGAGTGAGACTAGGGTCAAGTCAGTGCGTACCGGTCGAAAGCCTATTGGG 
                  
************************************************************ 
 
CKI_jap9wtT7      
AACCCAGAGGACGAGCAAGAGACTTCCAAGCCGAGTGACGATGAATTCTTAAGAGGAAAG 
CKI1_dna          
AACCCAGAGGACGAGCAAGAGACTTCCAAGCCGAGTGACGATGAATTCTTAAGAGGAAAG 
                  
************************************************************ 
 
 
 
Program Workbench lze využít nejen ke kontrole DNA sekvencí; mimo jiné tu lze srovnávat zadané 
sekvence proti databázím, překládat DNA sekvence do proteinových, vyhledávat primery... Dále lze 
Workbench použít i pro práci s proteinovými sekvencemi – taktéž srovnávání navzájem či přes 
databáze,  zjišťovat pI, ext. koeficienty... a spousta dalších věcí.  
 
Vaším úkolem bude zkontrolovat sekvence vzorků, se kterými budete pracovat. Výstupy 
z Workbenche přiložíte k protokolu. Vzhledem k časové náročnosti praktika a finanční náročnosti 
sekvenování nebudete ovšem sekvenovat a kontrolovat celý klon, ale pouze jeho začátek. Pro 
ovládnutí základů práce se sekvencemi to však bude zcela postačující.  
 
 
 
 
 
 
 
 
 

 
 
 



 

 

B) EXPRESE A PURIFIKACE REKOMBINANTNÍCH 
PROTEINŮ 
 

Mgr. Blanka Pekárová, Ph.D., MSc. Agnieszka Szmitkowska 
 
Častým průvodním jevem nadprodukce eukaryontních proteinů je vytváření nerozpustných útvarů 
v bakteriální cytoplazmě, složených obvykle z nekorektních konformerů rekombinantního proteinu, 
označovaných jako inkluzní tělíska. Důvodem jejich tvorby může být absence eukaryontních 
chaperonů nebo post-translačně modifikačních systémů a někdy i toxicita rekombinantních 
eukaryontních proteinů pro bakteriální buňky. Rozsah akumulace rozpustného rekombinantního 
proteinu může být pak silně negativně ovlivněn. Řadu obtíží se podařilo vyřešit translačními fúzemi 
rekombinantního proteinu a přirozených (obvykle bakteriálních) proteinů (např. thioredoxin, maltózu 
vázající protein, glutathion-S-transferasa atd.), které své pozitivní fyzikálně-chemické vlastnosti 
(zejména vysokou rozpustnost při zvýšených intracelulárních koncentracích) rozšiřují na celý fúzní 
protein. Další možností, kterou lze ovlivnit správné skládání proteinu, je změna podmínek exprese 
proteinu. Optimalizuje se teplota růstu buněk, teplota indukce exprese požadovaného genu, 
koncentrace IPTG při indukci, prodloužení doby indukce nebo růstu buněk. Lze i specificky 
obohacovat růstové médium. 
 
Podmínkou pro většinu analýz rekombinantních proteinů je získání rekombinantních proteinů 
v homogenní formě účinnou purifikací z komplexních bakteriálních lyzátů. Purifikaci lze usnadnit 
řízeným směrováním syntetizovaného proteinu např. do periplazmatického nebo vnějšího prostoru 
Escherichia coli užitím specifických signálních sekvencí, ale tato technologie může být spojena 
s nižším výtěžkem. Proto byly vyvinuty metody purifikace, jež používají nově získané afinity 
fúzované domény, která může mít podobu přirozených polypeptidů nebo krátkých arteficiálních 
oligopeptidů, které neovlivňují profil exprese -  mají pouze funkci afinitní značky (Hisn, Aspn, Phen 
atd.).                                                                              
 

Exprese rekombinantních derivátů -glukozidázy Zm-p60.r 
 
Pro expresi budou použity dva druhy konstruktu pRSET A::Zm.p60.r, z nichž jeden je WT a druhý 
nese záměnu jedné aminokyseliny. Studenti nebudou předem obeznámeni, zda jim byl přidělen Wt 
nebo mutant. Během cvičení však mohou postupně přijít na to, se kterou formou pracují. 
Tyto konstrukty náhodně označíme jako X a Y. 
Liché skupiny budou pracovat s proteinem X a sudé skupiny s proteinem Y.  
 
Experiment: 

 Do 1 l LB média s ampicilinem (100 mg/l) a 1% glukózou zaočkujeme 800 μl bakteriální 
kultury (BL21(DE3)pLysS buňky obsahující již zmíněný konstrukt pRSETA::Zm.p60.r.) 
zamraženou na – 80°C v 10% glycerolu. Necháme růst při 37 °C do OD600 0,5-0,6.  

 Poté zahájíme 3 hodinovou indukci exprese rekombinantního proteinu přídavkem 0,1mM 
IPTG a současně sníženíme teplotu na 22 °C.  

 Kultury sklízíme centrifugací (4000 rpm/20min). Pelety zamrazíme na -20°C. 
 
 

 

 



 

 

Purifikace proteinu 
 
Čistota proteinových preparátů je jedním z kriterií pro přesnost výsledků při následné analýze 
purifikovaných proteinů, proto je nutné provést purifikaci proteinu z bakteriálních lyzátů. Použité 
fúzní proteiny obsahují na N-konci sekvenci šesti histidinů, které umožňují využít metalochelatační 
afinitní chromatografie.  
Metoda byla poprvé využita v roce 1975 (Porath a kol.) pro frakcionaci sérových proteinů na 
polymerní matrici s funkční skupinou chelatující ionty přechodných iontů (Cu, Ni, Zn, Co). Funkční 
skupinou na matrici je obvykle iminodioctová (IDA) nebo nitrilotrioctová (NTA) kyselina. Interakce 
proteinu s matricí je zprostředkovaná neobsazenými d-orbitaly iontů přechodných kovů, které vážou 
volné elektronové páry převážně z dusíkového atomu imidazolových skupin histidinových zbytků 
v proteinu.  Tohoto principu bylo využito ke konstrukci umělých oligohistidinových domén (afinitních 
značek) na C- nebo N-konci rekombinantního proteinu. Značky vykazují ve srovnání s izolovanými 
zbytky histidinu v polypeptidech vysokou afinitu k vázaným přechodným kovům. Metalochelatační 
afinitní chromatografie se tak stala jedním ze základních purifikačních postupů pro rekombinantní 
proteiny. 
         Optimalizovaný purifikační protokol není vždy zcela přenosný na jiné proteiny z důvodů různé 
fyzikálně-chemické charakteristiky proteinu a také vazebné dostupnosti oligohistidinové domény. 
Obecně lze navrhnout pro vazbu rekombinantního proteinu pufry s pH = 7 – 8, zajišťující optimální 
interakci domény s kovovým iontem. V pufrech je vhodné použít vysoké koncentrace solí (0,5 – 1 M 
NaCl) a tím snížit nežádoucí elektrostatické interakce proteinů s matricí. Eluce proteinů může být 
provedena změnou pH do kyselé oblasti, kdy dochází k protonaci imidazolových skupin, případně 
použitím kompetitivních činidel (imidazol, některé aminokyseliny) nebo silných chelatorů (EDTA, 
EGTA). Použitím nižších koncentrací uvedených látek lze dosáhnout eluce balastních proteinů, které 
rovněž interagují s iontem přechodného kovu.    
 
 
Experiment: 

Příprava bakteriálního lyzátu pro purifikaci 
 
 Rozmrazíme exprimované kultury  
 Pelety resuspendujeme v sonikačním pufru (10 ml sonikačního pufru/pelet z 0,5 l kultury) 
 Lyzáty sonikujeme nejméně 3 krát 1 min   
 VYVÁŽÍME ZKUMAVKY S PŘESNOSTÍ NA 0,1 g a centrifugujeme 30 minut (20000 

rpm/4°C) 
 Pro odstranění nerozpustných zbytků se lyzát protlačí přes filtr o průměru 0,22 m  
 Přefiltrovaný supernatant použijeme na purifikaci proteinu na kolonkách. 
 Zhruba 200 l lyzátu uschováme na ledu pro následné měření koncentrace proteinů a 

strukturní a funkční analýzu. 
 

             Roztoky: Sonikační pufr: 20 mM Tris pH 7,9 
                                                       0,5 M NaCl 
                                                       0,1 % Triton X-100 
 

Purifikace fúzních derivátů Zm-p60.1 na matrici Sepharose Ni2+-
NTA 
 
 
Pro zisk čistého proteinu je nutné optimalizovat podmínky vymývání balastních proteinů. Změna 
složení promývacích pufrů ovlivní eluci balastních proteinů interagujících s iontem kovu. Jako matrice 



 

 

bude použita Ni – NTA Superflow a jako promývací pufry P1 a P2 lišící se koncentrací kompetičního 
činidla imidazolu.  
 
 
Pozn.: Sbírame frakce po každém promytí pro následnou SDS PAGE analýzu. 
 

 promýt kolonku 4x3 ml vody 
 promýt kolonku  1x2 ml 100 mM NiSO4 

(obsazení vazebných míst nosiče kolonky Ni2+ ionty)    
 promýt kolonku  4x3 ml vody 
 promytí kolonky  4x3 ml ekvilibračního pufru (poté uzavřít spodní část kolonky) 
 po nanesení lyzátu exprimovaných kultur kolonku uzavřeme, zvortexujeme a inkubujeme 30 

minut při 4°C  za třepání na ledu 
 promýt 3x3 ml pufru P1  
 eluce balastních proteinů 3x3 ml pufru P2 
 eluce vlastního proteinu 4 ml pufru E obsahujícího EDTA  
 frakce uschovat při 4°C pro následnou analýzu čistoty proteinu 
 kolonku promýt 2 ml vody 
 promýt 4 ml 20 % ethanolu (ne do sucha!)  

 
Roztoky:   Ekvilibrační pufr: 20 mM Tris pH 7,9  

                                           1 M NaCl 
        
         První promývací pufr (P1): 50 mM Tris pH 7,9 
                                                               1 M NaCl 
                                                                20 mM imidazol 
 

               Druhý promývací pufr (P2) : 50 mM Tris pH 7,9 
                                                                  1 M NaCl 
                                                                  50 mM imidazol 
 
          Eluční pufr (E): 20 mM Tris pH 7,9  
                                             1 M NaCl 
                                            100 mM EDTA 
                                             
     

 
Demonstračně bude předvedena purifikace stejná purifikace pomocí FPLC. 
 

 
Stanovení koncentrace proteinu  
 
Koncentraci proteinů stanovíme metodou dle Bradfordové při 595 nm;  činidlo firmy Bio-Rad nebo 
Sigma. 
Stanovíme koncentraci jen v nativních lyzátech ! 
 

 10 μl lyzátu naředíme 10 x sterilní vodou  
 Připravíme tři paralerní vzorky:  

 - 10 μl ředěného lyzátu doplníme sterilní vodou do celkového objemu  800 l   
  - přidáme 200l činidla a inkubujeme 10 minut při pokojové teplotě   
 změříme absorbanci při 595 nm  
 z kalibrační křivky odečteme množství proteinu 
 



 

 

ANALÝZA REKOMBINANTNÍCH PROTEINŮ 
 
 
Analýza kvartérní struktury rekombinantních proteinů a stupně purifikace bude provedena 
elektroforeticky v polyakrylamidových gelech. Obecně lze říci, že elektroforéza proteinů využívá 
jejich přirozeného nebo upraveného povrchového náboje v polymerních materiálech. 
Nejpoužívanějším separačním materiálem se stal síťovaný polyakrylamid umožňující vysokou 
reprodukovatelnost metody. Jistou nevýhodou polyakrylamidových gelů (PAGE) je vysoká 
neurotoxicita monomerů akrylamidu a metylenbisakrylamidu (slouží jako síťovací prvek). Při 
přípravě je tedy nutné pracovat v dobře větraných digestořích a v rukavicích. 
K iniciaci polymerace (přípravě radikálů) lze použít riboflavin ozářený UV nebo častěji persíran 
amonný (APS), jako stabilizátor radikálů se používá tetramethylendiamin (TEMED). 
 
 
 Každá skupina si připraví jeden 10 % SDS-PAGE gel s 10 jamkami 
 

DĚLICÍ GEL (10%)  NA 1 GEL 
 Acrylamid G30 1,7 ml 
4x dělicí pufr   1,25 ml 
dd voda 2 ml 
10% SDS 50 l 
10% APS 50 l 
TEMED 3 l 
KONCENTRAČNÍ GEL (5%)  
Acrylamid G30 250 l 
4x separační pufr 400 l 
dd voda 800 l 
10% SDS 16 l 
10% APS 25 l 
TEMED 1 l 

 
 
4x dělicí pufr           (1,5 M Tris-Cl pH 8,8) 
4x koncentr. pufr     (0,5 M Tris-Cl pH 6,8) 
 
Polymerace dělicího gelu musí probíhat bez přístupu vzdušného kyslíku, proto je nutno polymerační 
směs po nalití mezi skla přelít deionizovanou vodou. Po odstranění deionizované vody nalijeme směs 
pro koncentrační gel, vsuneme hřebínek a necháme polymerovat.  
 

 
Kontrola čistoty purifikovaného proteinu 

SDS-PAGE 
 
Nejvýznamnější aplikací polyakrylamidové elektroforézy (PAGE) je diskontinuální separace 
v přítomnosti dodecylsulfátu sodného (SDS) jako silného detergentu. SDS se váže na proteiny 
v konstantním poměru k jejich hmotnosti (1,4 g SDS na 1g proteinu) a umožňuje tak určit  Mr proteinů 
s využitím hmotnostních standardů. Úplné maskování původního náboje však není zcela zachováno u 
silně bazických nebo kyselých proteinů, kde je k přesnému určení Mr nezbytné použít dalších technik.  



 

 

Diskontinuální uspořádání zahrnuje krátký koncentrační gel a dlouhý separační gel. Koncentrační gel 
má nižší pH (6,8), dochází zde k zakoncentrování proteinů do úzkých zón mechanismy izotachoforézy 
(glycin zde není zcela ionizován a slouží jako terminátorový ion). V separačním gelu o pH 8,8 dochází 
k ionizaci glycinu, zóny proteinů se tak oddělují a proteiny se rozdělí podle molekulových hmotností. 
Metoda tak umožňuje detekovat v proteinovém preparátu kontaminující proteiny a slouží k testování 
úspěšné optimalizace purifikace proteinu z komplexních směsí.  
Separované proteiny lze vizualizovat některou z nespecifických technik barvení proteinů (Coomassie 
Brilliant Blue, barvení stříbrem), nebo lze použít specifické techniky (detekce enzymů pomocí 
chromogenních substrátů, Western bloting s následnou detekcí proteinu pomocí protilátek). 
 
Experiment: 
Našim cílem bude ověřit čistotu izolovaného proteinu. Na připravený denaturační gel naneseme 
postupně frakce eluované z kolonky během purifikace: 
 
 
 
 
 
lyzát P1 P2 Eluce FPLC Standard lyzát P1 P2 Eluce 

 
Každá skupina pracuje s přiděleným rekombinantním proteinem X nebo Y. Jednotlivé purifikační 
frakce naneseme na gel pouze orientačně, tzn., nebudeme měřit proteinovou koncentraci.  
 
1. Příprava jednotlivých vzorků je znázorněna v tabulce.  
 
označení 
vzorku 

objem vzorku 
(l)  

4 x koncentrovaný  
SDS nanášecí pufr (l) 

 
 lyzát 6 l  2 l 

P1 30 l  10 l  
P2 30 l  10 l 

Eluce 30 l 10 l 
 
Pozn:Vzorek proteinu purifikovaného na FPLC dostanete připravený stejně tak i  hmotnostní standard. 
 
2. Připravené vzorky povařime (90°C/10min) a krátce stočíme na stolní centrifuze. 
 
3. Do jamky naneseme 30 μl připraveného vzorku. 
 
4. Elektroforézu necháme běžet při 25 mA/gel po dobu 1-2 hod. Gel obarvíme roztokem Coomassie 
Brilliant Blue (Nespecifické barvení proteinů – viz. 2-D elektroforéza). 
 
Elektroforetický pufr :    25 mM Tris-Cl, pH 8,3 
                                        192 mM glycin 
                                        0,1% SDS 
 
4x koncentrovaný nanášecí pufr: 0,125 M Tris-Cl pH 6,8 
                                                     40% SDS 
                                                     20 % v/v glycerol 
                                                     0,2 M DTT 
                                                     Bromfenolová modř 

Skupina pracující 
s proteinem X 

Skupina pracující 
s proteinem Y Společné pro obě 

skupiny 



 

 

Analýza obrazu – stanovení čistoty purifikovaného proteinu 
 
 
Denzitometr GS 800, Bio-Rad  
Software pro analýzu 1-D gelů: Quantity One, Bio-Rad 
Adobe Photoshop 
 
Provedením samotného experimentu práce zdaleka nekončí. Získaná data je potřeba ještě správně 
vyhodnotit a interpretovat.  
V našem případě bude vyhodnocení spočívat v určení čistoty proteinu (eluční frakce). 
 
1.Skenování gelu 
•  zapnout denzitometr 10 minut před vlastním měřením; restartovat počítač; 
•  na sklo přístroje nakapat střičkou destilovanou vodu (skenujete-li membránu, sklo    
   nenámáčíte); 
•  vložit gel, odstranit případné bubliny a zavřít přístroj.  
•  spustit program Quantity One; 
•  z nabídky vybrat File → GS-800 
•  v menu vybrat, jaké médium skenujete:  
 Select → Gel → Coomassie Blue  nebo 
 Select → Blot → AP-substrate (BCIP/NBT) 
  a podle toho vybrat filtr: pro gel (skenuje se při λ=520-570 nm) se použije filtr   
  zelený, pro blot (skenuje se při λ=595-750 nm) červený. 
 Filter → Green, Red 
•   Preview scan 
•  Orámovat žádanou plochu, spustit skenování ikonkou Acquire 
 
2. Vyhodnocení gelu: 
Sledujete zastoupení daného proteinu ve směsi ostatních proteinů bakteriálního lyzátu. Tento poměr se 
vyjadřuje jako čistota vzorku. 
 
•  v programu Quantity One otevřít příslušný soubor: File →Open 
• pokud je obraz nakřivo a chcete jej narovnat, nebo pokud jej chcete otočit o libovolný úhel či ořezat, 
vyberte příslušný pokyn z nabídky Image 
 
• Korekce pozadí: buď lze odstranit pozadí v rámci jednotlivých drah, nebo se ode všech drah odečítá 
průměrné pozadí celého gelu. Jaký typ korekce zvolit, závisí na vzhledu a druhu konkrétního gelu 
(gradientový gel, přebarvení, smír, nečistoty…) 
 Background box – pozadí se definuje tím způsobem, že se zvětší a vybere reprezentativní oblast 
gelu (box), která neobsahuje data. Průměrná hustota tohoto reprezentativního kousku gelu se potom 
odečítá od hodnot dat 
 Bacground strip – používá se pro gely, kde se pozadí na horním konci dráhy liší od pozadí na 
spodním konci dráhy. Jako reprezentativní kus pozadí se vybere pruh shora dolů přes celý gel. 
Průměrná intenzita horizontální řady pixelů v dráze pozadí se potom odečte z každého pixelu dat ve 
stejné horizontální řadě v rámci celého gelu. 
 
Filtrace obrazu: podle vzhledu gelu zvolíme také typ filtrace: 
 Pepper, Salt, Gaussian, Uniform, Outlier 
  
 Pepper/Salt: šum a nečistoty jsou tmavší/světlejší než okolní pozadí. Tento  

druh šumu je častý u el. kamer; může být způsoben také škrábanci na  
negativu 
Gaussian: skvrny mají gaussovský profil. Obvykle “elektronický artefakt” nebo rozptyl světla 
na objektech 



 

 

Uniform: je-li svinčík po celém gelu (šmouhy, smíry a pod.) 
Outlier: sem patří I Pepper a Salt. Jde zejména o nečistoty vnějšího původu: prach na skle 
skeneru, skvrny na gelu a pod. 

Velikost filtru: od 3x3 do 9x9 pixelů. Nutno vybrat takovou velikost filtru, aby byla větší než 
průměrná velikost pozadí ale menší než průměrná velikost dat. Jednoduše řečeno, není dobré si 
odfiltrovat spolu s pozadím i bendy. 
Ve vašem případě pravděpodobně použijete:  

korekce Pepper, Gaussian noise, Filter size 3x3 pixels 
z nabídky Image → Filter Wizard 

Filtrování obrazu je nevratná operace, původní – nefiltrovaný – obraz si proto pro jistotu 
uložíte. 
 
•  Definování drah: 
Pro vyhodnocení zastoupení proteinu je nutné definovat jednotlivé dráhy. Pokud se srovnávají bendy 
vzájemně mezi dráhami, musí být linie, definující jednotlivé dráhy, stejně dlouhé; toto je obvzlástě 
důležité v případě, srovnávají-li se mobility bendů vůči standardům. 
Dráhy lze definovat buď jednotlivě nebo jako síť po celém gelu, manuálně nebo automaticky. Dráhy je 
vhodné nastavit o něco širší, než jsou bendy. Veškeré operace s dráhami najdete v nabídce Lane. 
Nejrychlejší způsob, jak dráhy definovat, je automatické vyhledávání: Lane → Auto Frame Lanes; 
případné nedostatky lze poté napravit manuálně – např. přidat či odebrat dráhu, zakřivit dráhu podle 
zakřivení gelu a pod:  

 Lane → Edit Frame → Stretch Frame 
      → Move Frame 
      → Rotate Frame 
      → Resize Frame 
      → Add/adjust Anchors… 

 
•  Definování bendů   
Také bendy lze vyhledat automaticky i manuálně. Každé uspořádání má své výhody I nevýhody. Opět 
nejrychlejší způsob je vyhledat bendy automaticky a poté manuálně přidat, upravit nebo odstranit 
bendy. Příkazy pro operace s bendy najdete pod nabídkou Band. 
 
• Pokud je detekce bendů hotová, pro zobrazení výsledků použijete povely z nabídky Report. Lze 
zobrazit výsledky ze všech drah najednou nebo zobrazovat dráhy po jedné. Výsledky lze také 
exportovat do textového souboru. 
Převedení obrázku z formátu tif na formát jpg: 
File  Save As  z nabídky formátů zvolit jpg.  

Popsané obrázky naskenovaného gelu budou součástí protokolu. 

 

C) Strukturní a funkční analýza proteinů 
 
Místně řízená mutageneze spolu s určením kinetických parametrů enzymů se stala klíčovou metodou 
pro studium vztahů mezi strukturou a funkcí proteinů. Pomocí tohoto přístupu lze v molekule proteinu 
detekovat aminokyselinové zbytky podílející se na katalýze přeměny substrátu, na rozpoznání a vazbě 
substrátu a také ty aminokyseliny, které hrají důležitou roli pro poskládání proteinu do správné 
kvartérní konformace, která je často podmínkou pro funkci proteinu. Může se však stát, že záměna 
jediné aminokyseliny má katastrofické důsledky, které vedou ke zborcení nativní struktury a ztrátě 
funkce proteinu. Často také mutace ovlivní pouze funkci enzymu (a nemusí se vždy jednat o negativní 
změnu), v některých případech je vliv nulový. 
Analýzu struktury a funkce enzymu je možno provést již v nativních bakteriálních lyzátech, čímž se 
ušetří spousta experimentální práce spojené s izolací proteinu. Jedinou podmínkou je mít po ruce 



 

 

dostatečně specifický detekční systém pro daný protein. V této části si ukážeme, jak lze analyzovat 
strukturu a funkci Zm: p60.1 v bakteriálních lyzátech pomocí nativní elektroforézy a jaký dopad má 
záměna jedné aminokyseliny na kvartérní strukturu a následně pak i funkci proteinu. 
 

Nativní PAGE 
 
Tato elektroforéza se provádí v nepřítomnosti SDS a za důsledného chlazení aparatury, abychom 
udrželi protein v nativním a tedy aktivním stavu. K separaci proteinu nativní PAGE dochází na 
základě velikosti, náboje a také na tvaru proteinu. Elektrický náboj proteinu závisí na 
aminokyselinovém složení proteinu a jeho posttranslačních modifikacích. Celkový povrchový náboj 
proteinu se může měnit podle pH použitého elektroforetickém pufru. Pokud se provede nativní 
elektroforéza za neutrálního pH, je pak tato metoda použitelná pro studium procesů, při kterých se 
mění náboj (např. při chemické degradaci proteinu – deamidace) nebo pro studium konformace 
proteinu (oligomerizace, tvorba agregátů, rozvolnění struktur, protein-protein nebo protein-ligand 
interakce).  
Využívá se opět diskontinuálního průběhu separace (viz SDS PAGE). 
Vizualizace proteinu můžeme provést specificky např. barvením na základě aktivity enzymu pomocí 
chromogenních substrátů (v případě naší glukozidázy: 6-bromo-2-naftyl--D-glukopyranosid – 
BNGP, 4-methylumbelliferyl--D-glucopyranoside - MUG) nebo po přenesení na membránu s 
následnou detekcí pomocí série protilátek. Lze požít také nespecifického barvení Coomassie Brilliant 
Blue. 
 
 
Experiment: 
K ověření katalytické schopnosti (His)6Zm.p60.rm (rekombinantní derivát glukozidázy a jeho 
mutantní formy) proteinů X a Y použijeme aktivitní barvení na nativní PAGE s využitím substrátu 4-
methylumbelliferyl--D-glucopyranoside (MUG). V místě bendu odpovídajícímu glukozidáze 
dojde ke štěpení glukosidické vazby v molekule substrátu za tvorby fluorescenčního produktu 
viditelného působením UV záření. Kvartérní strukturu budeme analyzovat pomocí imunodetekce. 
 
Na nativní gely naneseme nativní lyzáty proteinu X a Y. Podle stanovené koncentrace proteinů 
v těchto lyzátech si každá skupina připraví dva vzorky. Vzorek, který bude nanesen na gel a následně 
použit na aktivitní barvení bude obsahovat 100g na jamku (viz obrázek níže gel č. 1) proteinu a 
vzorek použitý pro přenos na membránu s následnou detekcí pomocí protilátek 20 g na jamku (viz 
obrázek níže gel č. 2). Vzorky označte X nebo Y, podle proteinu, s kterým pracujete a číslem skupiny.  
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Gel č. 1 : Aktivitní barvení pomocí MUGu - substrátu -glukozidázy – 
FUNKČNÍ ANALÝZA 
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Elektroforézu necháme běžet v chladové místnosti při 25 mA/gel po dobu 1-2 hod.  
 
Elektroforetický pufr:    25 mM Tris-Cl, pH 8,3 
                                        192 mM glycin 
 
Gel č.1: aktivitní barvení: 

 Po dokončení elektroforézy ekvilibrujeme gel 2 x 30 min ve vychlazeném  50 mM 
citrát/fosfátovém pufru (pH 5,5) při 4°C. 

 Gel vložíme na cca 10 min do barvícího roztoku při RT 
 Detekce proužků na transluminátoru, focení. 

 
Barvící roztok: 50 mM citrát/fosfátový pufr 
                         0,8 mM polyvinylpyrrolidon 
                         3 mM MUG 

 
 

Gel č.2: Imunodetekce na membráně 
 
 

Imunodetekce 
 
Jednou z hojně používaných specifických technik detekce proteinů je imunodetekce. Pro některé účely 
(hmotnostní spektrometrie, imunoanalýza apod.) je výhodné převést separované proteiny z gelu na 
membránu. Mezi nejčastěji používané materiály membrán patří nitrocelulóza (má však špatné 
mechanické vlastnosti) a polyvinylidendifluorid (PVDF). PVDF membrány jsou mechanicky velmi 
odolné a vykazují vysokou vazebnou kapacitu. 
Používané techniky přenosu zahrnují kapilární a elektrický transfer, pro svou časovou nenáročnost je 
zvláště rozšířen polosuchý (semi-dry) přenos. 
Imunochemická detekce proteinu na membráně se provádí pomocí série dvou protilátek. 
První protilátka reaguje imunochemicky s detekovaným proteinem za tvorby komplexu. Takto 
vytvořený komplex je rozpoznán druhou protilátkou značenou detekovatelnou sondou (např. vázaná 
alkalická fosfatáza, atom izotopu atd.).  
 

 připravit membránu PVDF, 4 papíry Whatman 3MM podle rozměru gelu 
 ekvilibrace ponořením PVDF do MeOH (snížení hydrofobicity membrány) 
 inkubace PVDF membrány v dd H2O (5 minut) 
 ekvilibrace papírů, gelu i membrány v transferovém pufru (10 minut) 
 semi-dry elektro transfer 30 min. (proudová hustota = 5 mA na 1 cm2) 
 inkubace 45 min s blokačním pufrem 

Gel č. 2 : specifická detekce β- glukozidázy pomocí série dvou protilátek po přenesení na 
membránu- STRUKTURNÍ ANALÝZA 



 

 

 45 min inkubovat s primární protilátkou  
 promývat  3x 5 min TBST 
 inkubace se sekundární protilátkou (45 min) 
 promývat  3x 5 min TBST 
 inkubace s detekčním pufrem (10 min) 
 detekce inkubací s roztokem chromogenního substrátu (max. 5min.) 
 opláchnout vodou a usušit 

 
Roztoky : transferový pufr                                         TBST 
                 25 mM Tris-Cl, pH 8,3                                20 mM Tris-Cl, pH 7,6 
               150 mM glycin                                             100 mM NaCl 
                 10 % methanol                                             0,1 % Tween-20 
 
               detekční pufr                                               blokační pufr 
                100 mM Tris-Cl, pH 9,5                              5 % sušené mléko v TBST 
                100 mM NaCl 
                    5 mM MgCl2                                             

      
               barvící roztok: 100 mM Tris-Cl, pH 9,5                                
                                         100 mM NaCl 
                                         5 mM MgCl2                                             

                                   100 g.ml-1 NBT 
                                     80 g.ml-1   BCIP 
          
Primární protilátka: 
Polyklonální králičí Anti-Zm.p60.1 (LMFR-VÚVEL); 10 000 x ředěno v 5% BSA v TBST 
Monoklonální myší Anti Poly His (Sigma); 10 000 x ředěno v 5% mléku v TBST 
 
Sekundární protilátka: 
Kozí IgG proti králíčímu séru značená alkalickou fosfatázou; 30000 x ředěno v 5% mléku v TBST 
Kozí IgG proti myším IgG značená alkalickou fosfatázou; 20 000 x ředěno v 5% mléku v TBST 
Chromogenní substrát: NBT (nitrobenzentetrazolium), BCIP(5-bromo-4-chloro-3- indolylfosfát).  
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Purifikace IMAC 
Ni-NTA 

SDS-PAGE 
Native PAGE 

Zaočkování 800 µl zamraženého bakteriálního inokula do LB média obsahujícího ampicilin 
(100 mg/l) a růst do OD600= 0,5-0,6  (ZHRUBA 3 hod) 

Indukce exprese rekombinantních proteinů pomocí IPTG ( 0.1 mM) při 22°C po dobu 3 hodin 

Sklízení buněk centrifugací 15 minut (4000 rpm  při 4°C)- každá skupina stočí 250 ml kultury a 
resuspenduje v 5 ml sonikačního pufru 

Odstranění buněčných zbytků centrifugací při 20000 rpm po dobu 30 min. při  4°C 

Strukturní a funkční analýza 

  Sonikace 

Vyhodnocení čistoty: 
Quantity One 

Imunodetekce na 
PVDF membráně 

Aktivitní 
barvení 


